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A Drone Safety Precautions

m Pilot's Code of Conduct
Pilots of ultralight flying devices (drones) must comply with the regulations stipulated by
the Ministry of Land, Infrastructure, and Transport to prevent damage to people or
property caused by ultralight aircraft

o No night flights from sunset to sunrise

elif it is difficult to fly safely due to blurred vision such as fog or rain, and if the flight
cannot be seen with the naked eye, it is prohibited to fly in the non-visible area

® Control zone (within a radius of 9.3 km from the airfield) No flights

®Prohibition of flying in areas where flights are prohibited for national defense or
security reasons, such as the area around the ceasefire line, Gangbuk in Seoul,
around the nuclear power plant (radius of 18.6 km), airports or airfields where
aircraft take off and land, etc.

e Do not fly in the airspace where the aircraft’s flight route is installed (at an altitude
of more than 150 m)

e Do not fly in densely populated areas or places where there is a risk of casualties if
the aircraft falls, such as over a crowded area

@ Prohibition of dropping objects during flight

e Prohibition of flying under the influence of alcohol

Tip. No-fly zone check app: Ready to fly

m Safety Checks:
Please be sure to conduct a safety inspection before, during, and after the flight of the
ultralight flying device (drone).

® Pre-flight safety checks
- Check remote controller on and charging status
- Check battery power connection and charging status
- Check for propeller damage and motor binding
- Check the appearance of the arms, landing gear, frame, etc.
- Check airspace, weather, and obstacles and secure a safe distance (15m)

- Final check of communication status such as GPS, wifi

® Check the operation after takeoff
- Move up, down, forward, backward, left, right, and check the left and right




hovering movements before flying

® Post-flight safety checks
- Disconnect battery power
- Remote Controller Off

- Inspection of the propeller, motor, arm, landing gear, frame, etc.

n ArgoALES Overview

@ Software Overview

argosALES




argosALES software is an installable software that can

control multiple drones and stations for multiple drones

If the drone, station, and argosALES are in the Internet environment,
they

can be controlled through integrated control anywhere.

You can use the platform effectively through various features and

customization.

argosALES Key Features

m Display device information
o Device-specific status information display function through various
information windows
o Device-specific operation and flight control functions via the control
panel

o Various default settings change function through the setting window

m Patrol Planner
o Ability to control and edit the drone's flight path and detailed
movements
o Mission upload and download function
o PC save and load function of missions
o Survey Mode automatic conversion of flight paths
o Provides the ability to repeat the saved flight path
®m Providing essential convenience functions
o Provides an information window that makes it easy to check on-site
weather information
o Ability to change GCS default settings for the main use environment

Provides detailed operation function of the camera mounted on the aircraft

(limited to the company's aircraft, the other type can be adjusted after consulting with the company)



@ Recommended Specifications

Operator MS Windows 10 (64bit)
Processor Intel Core i5 3.2 GHz or faster
Memory 8 GB RAM or more

Low longitudinal
500 GB or more
volume

Internet Internet required




Screen configuration - main menu

@ argosALES screen configuration
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® Main Menu Area
m  File Menu (Flie Menu)
o Provides the ability to terminate the program.
B Registration Menu

o You can assign a task by registering an aircraft to argosALES, or you can
disconnect it from the program.

®  Tool Menu

o This menu allows you to manipulate the payload mounted on the drone, enter
commands to the camera, and use additional functions such as patrol control,

drone navigation, and screen locking.



m Display Menu

o When argosALES is enabled, the 'Flight Map' screen that can be seen for the first
time is provided as a screen function that suits the user's preference. In addition,
it also provides the ability to display drone information and station device
information.

®  Widget Menu

o This is a menu that provides indicators that display status information such as

drones, stations, and weather provided by argosALES.
B Settings Menu

o It provides the ability to adjust the theme of the argosALES, adjust the overall
settings, and modify the operation of the drone and station.

B Help

o This is a feature that provides support for using the program.

® Information Areas
m D

o Represents an ID value that shows the order in which the devices are
connected.

H  name

o Displays the name of the connected aircraft.

m  type
o Displays the frame shape of the aircraft.
m  Start-up status
o Indicates whether the aircraft is started or not.

H version
o Indicates the firmware version of the BirdCom board on which the aircraft is
mounted. The firmware must be kept up-to-date.

B |atitude



o Displays the latitude value of the aircraft.

longitude

o Displays the hardness value of the aircraft.

height

o The gas represents its absolute altitude from sea level.
Direction angle

o 0/360 °: North,

o 90° East

o 180°: South
o 270 °: West
battery

o It numerically indicates the voltage of the battery installed in the aircraft.
Number of satellites

o  The number of satellites recognized by the GPS mounted on the aircraft. At

least 10 aircraft are operating normally.
DOPE
o Displays the quality of the drone's GPS. It works most accurately below 0.8.
Flight Mode
o Indicates the command status that the aircraft received from the GCS.
Communication method
o When registering a drone, indicate the connection type with an icon.
Communication Status

o Displays the communication status of the aircraft with an icon.



Getting ready

argosALES is shipped to licensed drones and stations with pre-registration and basic settings
completed. Registration of new equipment can only be done through the Customer Support
Center.

@® Drone Registration

® Inthe 'Register Drones’ menu, you can connect | =+ argosALes
pre-registered drones to argosALES.
®  Check 'Drone' in the 'Drone Registration’
window and select 'Connection Type'
1. Drone: Set the device (device) to be

registered as 'Drone’.

2. Click the list of equipment registered

in 'Device Name' and register the

station.

3. When the registration is successfully completed, the 'Device Information

Window' displays information about the registered aircraft and the

I
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connection status. @
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@ Connection type - Connection settings according to the communication

environment




& | |
1. loTHub — A service hosted in the cloud \

and serves as a central hub for two-way Cjupo] 2
communication between IoT applications ¢ =2 =Ho18
and the devices they manage. 028 E}O!
® loTHub MQTT
2. MQTT - This protocol is optimized for mobile J TCP ube

. . . RF Telemerty

devices and small devices with low
. : [] LoRaWAN

bandwidth. Messages can be transmitted
reliably even in slow, low-quality network HHH0I= OIS

. testUAV v
environments.

3. TCP - Set the communication connection

ojn
in
{

-

type to E a TCP type that supports

connected services on top of the protocol.

4. UDP &&_ Set the communication connection type to UDP. It's less reliable than
TCP, butit' s faster.
LA 4
5. RF Telemetry - Connect using telemetry or radio communication. There is a
limit to the communication distance depending on the transmission distance of the
antenna. In the same way as Cloud Link, you can remotely control the drone and

receive status information.

6. LoRaWAN &ﬁ— a protocol that enables long-distance transmission with low

power consumption.
® ol device name

o You can load a list of aircraft registered in ALES-C and assign a task to the aircraft by

registering it.




® Multi-drone registration

® When you want to register multiple drones at
once, you can register multiple drones quickly

and easily through the ‘Multiple Drone
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gases in the list at once.

o Aircraft wishing to cancel < registration

((should be restored to the pre-registration
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state using or .

@ Station Registration

® In the 'Register Station' menu, you can connect
. argosALES

a pre-registered drone to argosALES. Iy s&
m  Check 'Station’

window and select ‘Connection Type'

(=

in the 'Register Station’

1. Station: Set the device (device) to

register as 'Station’.

2. Click the list of equipment registered

28 0] siA

in 'Device Name' and register the LS AE0)4 3R

station.

3. When the registration is successfully completed, the 'Device Information

Window' displays information about the registered aircraft and the

Py
—

connection status. *



® Multi-station registration

If you want to register multiple stations at

once, you can quickly and easily register

multiple stations through the ‘Multi-

Station Registration’ function.

o Click the )arrow to

stations in the list at once.

" register all

o Stations that wish to deregister < will

((be reinstated to their pre-registration

status using or .

® Terminate the connection

'‘Disconnection’

1. You can terminate the drone = argosALES

connection in argosALES with the

‘Disarm drone' or
drone' button in the

Menu'.

'All Drones Disconnection'

‘Disarm all

'‘Register

1. This function allows you to

disconnect all aircraft currently

connected to argosALES at once.
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n Pre-flight setup

Before performing full-fledged drone flight control with argosALES, you can make a safer

flight by adjusting the main settings of the drone in consideration of the surrounding

environmental factors.

@ Set drone defaults (drone settings)
® Set flight defaults
m  Setting path: Setting > Drone Drone > Settings
1. Flight speed
- Set the maximum flight speed of the aircraft in km/h.
2. RTL Altitude

- RTL commands set the default altitude value when the drone returns

to its home position.
3. Landing altitude

- Specifies the altitude at which the 'Landing Speed’ setting applies
when the aircraft lands. Above the landing altitude, it descends at the
default landing speed, and from the set altitude it descends at the
landing descent speed and lands.

4. Landing speed

- Set the descent speed upon landing.
5. Home Location

- Set the latitude and longitude coordinates of the aircraft.
6. Set up FailSafe

- Battery voltage: When the remaining battery reaches the set voltage

value, the aircraft automatically returns.

- GPS quality: When the set DOP value is reached, the aircraft will

automatically return.



7. Automatic heading at RTL

- At RITL, it is decided whether to return to the drone's heading angle at
the time of takeoff. If this setting is enabled, the drone will land after
RTL and maintain the heading angle at the time of takeoff when
landing.

H Basic flight

You can control the drone you want to fly by selecting the connected drone from Tools" '>
Drone Control'.

@ Configure the 'Drone Control Window'

e Starting/turning off the engine

Ming Ching Establishment

a\\\' Arming It is used to turn on/off the engine of the aircraft.

@ Drone Flight Control — Using the '‘Drone Control’ function

e Control window configuration

! ! !| uavMice4 . |




m 1. Aircraft List Window — After setting the registered aircraft through the list list,

you can operate the aircraft using the controller pad.

B 2. Start Control Button - This button starts the aircraft with the guide mode set and

puts it in a waiting state for takeoff.

m 3. Flight mode control button — The types of flight modes are as follows.

- Control Mode

icon ‘ Ming Ching Establishment
9 Apply a mode that allows you to steer the aircraft with
<?O Guide Mode GCS.
It is used for pause and resumption during missions.
kv | Altitude holdin
3 J The altitude of the aircraft is fixed.
- mode
+'5' Return Mode Land where you took off.
v | Position-locked ] o ] )
Both the altitude and position of the aircraft are fixed.
mode
et Automatic flight o
Use to resume a suspended mission.
AUTO | mode P
ey
U Landing Mode The aircraft lands in its current position.
This is the default before changing the control mode.
Manual Mode This is a condition in which you need to directly control
all the attitudes of the aircraft.
b
Reuters Mode (Unimplemented)
B 4. Take-off button — The 'Start Control’ button takes off the aircraft in the arming
state.
m 5. Remote Control Button — Utilizes the controller pad implemented in argosALES to
enable movement and operation of the aircraft .
m 6. RTL button - Return the aircraft to the point where it took off and land.
B 7. Landing button - Lands from the point where the aircraft is currently located.



8. Test flight button — Performs basic flight testing of the aircraft in automated step-

by-step steps.
9. Grid Map Display - Displays the location of the aircraft in coordinates supported by the map service.
10. Meter display - indicates the absolute altitude of the aircraft from sea level.

11. Vehicle Start-up Status Display — Indicates the current start-up and operation

status of the aircraft.

12. Aircraft Flight Mode Indication — Indicates the status of the command received
by the aircraft from the GCS.

13. Communication Connection Status Display - Indicates the status of the

communication connection between the aircraft and the GCS.

Starting the engine

B In the 'Drone Control' window, click 'Guide Mode' to make the drone

Q
controllable for argosALES. If the 'Guide Mode' is activated, release the =)

‘Safety Button' on the aircraft, secure a safe distance, and press the 'Start

%,
Control' button to start the drone. ¢~
Poetry East Sea

m Before the drone takes off from the arming state, the user will release the

-
drone's arming by pressing the 'Start Control' da‘ button once more, if

desired.

Depending on the type of aircraft, a GPS safety button may be provided.

Before starting the engine, please release the safety button and keep a safe

distance before starting the engine.

Set take-off altitude and take off



® |n the 'Drone Control' window, click the 'Takeoff Control' icon at the bottom,

and then move the drag bar or adjust it with the arrow keys to set the take-

off altitude. Once the take-off altitude is set, tap the 'Run @ "icon in the
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middle to take off.

It won't work until the drone starts up.

e Getting there

m With the drone taking off, you can move the drone

forward/backward/left/right/up/down through ‘remote control " After
clicking the ‘Remote Control' icon, set it to the aircraft you want to control in
the aircraft list window ((1)) at the top of the status window, check the
distance you want to move on each axis of X, Y, and Z ((2)), enter a number,
and click the move button ((3)) of the ‘Controller' to move to the corresponding
location. If you enter a value after checking the angle input window ((4)), the

aircraft will rotate according to the entered value.
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Ming Ching ‘ explanation

b Land It lands directly below the current flight
\V, position.

- | Return to the location from which you took
~—

— off and land.

e Basic flight test

B After selecting the aircraft you want to control, you can control the test flight

with 'Basic Flight Test'.

® In the 'Application Settings' window, you can modify the default flight test
(test flight setpoints) settings.

® Flight Information Monitoring

e Inthe 'Screen' tab, you can select the desired map from the satellite view/street

view functions to monitor.
e Satellite view

B You can monitor aircraft registered as ALES on a map taken by satellite.



e Street view

m  The map is implemented in Street View, and aircraft registered with ALES can

be monitored.
e Device Information

m At the bottom of the main screen, information about the aircraft is displayed
with icons and numerical values to understand the drone's status, location,

altitude, and communication status.
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o ID: An ID value that shows the order in which the devices are connected.
o Name: Displays the name of the connected drone.

o Type: Displays the frame shape and station of the drone.

Ming Ching explanation
The form of the connected drone is a
Quadcopter
quadcopter.
* The form of the connected drone is a
Hexacopter
hexacopter.
* The form of the connected drone is an
Octacopter
octacopter.
. _ The type of connected equipment is the
Station )
station.

o Start-up status: Displays whether the drone is started or not.
icon ‘ Ming Ching ‘ explanation

Ignition off The connected drone is turned off.

The connected drone is in a state where it is
Ignition on

®O

ignited and can take off immediately.

o Version: Indicates the firmware version of the BirdCom board on which

the aircraft is mounted. The firmware must be kept up-to-date.

o Latitude, longitude: Indicates the coordinates of the gas' latitude and

longitude.



Altitude: Indicates the absolute altitude of the gas from sea level.

Direction Angle: Displays the direction angle of the aircraft. The
directions are as follows.

- 90 °: East- 270 °: West- 180 °:

South-
0/360

°: North,
Number of satellites: The number of satellites recognized by the drone's

GPS. It works most accurately in 10 or more.

DOP: Displays the quality of the drone GPS. It works most accurately
below 0.8.

Flight Mode: Indicates the status of the command received by the aircraft
from the GCS.

Communication method: Indicates the communication connection method
between the aircraft and the GCS. If the connection is not successful, X

it will be marked as an indication.
B |oTHub - 0 Cloud hosting-based service.

m MQTT — This protocol is optimized for mobile devices or small,
low-bandwidth devices.
LA 4
m  RF Telemetry - A connection using telemetry or radio

communication.

m TCP % - This is a setting that supports connected services on top of

the protocol.
m UDP sﬁ - This is a less reliable, but faster connection type than TCP.

m |loRa - &&A type of connection that enables long-distance

transmission with low power consumption.



o Communication Status: Indicates the communication status of the aircraft

N
()
0

or station. If it is connected normally, it will be displayed, and if it is

not connected, it will be X displayed as an indication.

e Take advantage of the device control area and notification area

B In ‘Drone Control' and 'Remote Control>" , simple information such as the

starting status and the current flight mode are displayed as icons.

B In the notification area, you can also check the start-up, mode, communication

type, link, and battery capacity with icons.
e Take advantage of other convenience features
m Take advantage of 'drone navigation'

o If the selected drone is off-map, > you can use the tool '‘Drone Navigation'

to move the map screen to the drone’s current location.
B Zoom in and out of the map

o You can roll the mouse wheel to zoom out and zoom in on the map. It
changes around the position of the cursor. If the drone icon and the cursor
are in close proximity, zooming out and zooming out will not work to

prevent mistyping.



H Automatic flight using Patrol Planner — Mission Flight

Mission flight is a function that creates and flies a straight path in the area to be controlled
and monitored, and it is a function that allows the user to fly in the desired area by

connecting multiple waypoints.
@® Create a 'Mission Flight' route using the Mission Planner

® Import the Mission Planner: In the Tools tab, click '‘Patrol Control’ to create a Patrol
Planner.

® When the 'Patrol Planner’ window is created, click 'Add Drone’ in the planner

window to select one of the registered aircraft.
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® After 'Add drone’, click ‘Add mission' in the 'Patrol Planner’ window, create a 'mission
planner’, double-click the desired route on the map to create a route, add commands

to create a flight route.
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ID: Displays the order

B2 A2 corresponding to each

waypoint of the drone by
number.

®m  Command: Indicates the
command that is applied to the

drone.



® ‘'Mission Flight' starts with 'Home Point’ and flies, and the mission path double-clicks
on the desired point on the map to create a waypoint, and then adds the desired

command to each waypoint so that you can perform actions suitable for the mission.

®

® Toadd a '‘command’, click the ‘Mission Planner' ‘Add ' tab to grant the desired

command.



® The types and functions of the commands are as follows.

Honorable explanation
mention

This is the first point where the drone waits
groove
before takeoff.

takeoff The drone gains altitude from the ground.

The drone will move to the waypoint you want to
movement
move.

landing Land your drone at a designated waypoint.

delay Hovers the drone at the designated waypoint.

Specify the point at which the drone will land in
NEW HOME

a new place.

The drone will return to the designated home
Return . .
point location.

Rotation Rotate the aircraft in the desired direction.

Start recording video from the camera mounted

Start of .
o on the aircraft.
Filming
(If the camera is attached)
Stop .
_ End the recording.
Shooting
Perform the command to take a picture of the
Photography

camera and save it as an image file.

¥ The mission information generated by the Mission
Planner can be accessed from W aypoint files
(*.wps) format and can be saved and loaded to a
PC.




@ Managing Waypoints/Mission Lists (Waypoint List)

e If you want to execute a waypoint command with a different
command, you can click the 'Edit’ tab at the bottom of the 'Mission
Planner' to change the existing command to a different command.
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® Delete waypoints/missions
® You can delete them by specifying the waypoints you want to delete.

® The 'Delete’ tab at the bottom of the 'Mission Planner' deletes only
the specified waypoints and missions, and the '‘Delete All' tab deletes

all waypoints that have been created so far except for ‘Home



@ Applying waypoints/missions

® After creating a waypoint/ mission, click the ‘Apply’ tab at the bottom of the
‘Mission Planner' and click the OK button in the notification message window,

and the information about the specified aircraft (drone) and mission will be

displayed in the 'Patrol Planner * window.
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® Running a Mission Flight

® (Click the 'Patrol Planner’, -> list at the bottom of the remote controller to set it to
the drone corresponding to the mission you created, click the 'Start’ button, and
the aircraft will start performing the mission flight according to the command

entered.

® Information on the aircraft's position, altitude, angle, and battery status can be

found in the 'Device Information’ window at the bottom of the map screen.



® Using the Patrol Planner to add multiple missions and 'triggers'

You can create a mission flight path in the order of ‘(1) Create a ‘Mission Flight'
route using the Mission Planner’, and then add another route you want in the same

way to create a flight path.

You can use the ‘Add Trigger' function in the 'Editor’ list of the 'Patrol Planner’ to

set the flight start conditions to the desired settings when the flight starts.

Eg|H Ml = @ Delay: The aircraft waits on the ground for a

_ set amount of time before performing the
MZHEEE 2 ETH R,

mission flight.
pA [ B

= ® Timer: Set the mission time on the PC, and
AMZ(Z) | 10 Min - when the set time is reached, the mission flight

begins.

Jhak

HEI Ha
® Full Charge: When the battery reaches its
full charge voltage value, the mission flight

begins.

Charging voltage setting: Set the target charging voltage value of the battery
installed in the aircraft arbitrarily, and when the set value is reached, the mission

flight begins.

Iterations: You can set the total patrol repeat count.

If the patrol repeat count is 0, the mission is repeated indefinitely.




@ Saving and reading flight paths

® You can use the save/retrieve function to save and retrieve ‘Mission Flight' so that

you can continue to use previously used missions without having to rewrite them.

~ || Search in Documents pel

™ LHPC » EZEO23(C) » Users » user * Documents ¢

New folder
4 Documents B Adobe
.4 Adobe
AFEA X E Office M4
FiFt2E w2 oy

.4 * Downloads

AM-EXE K| E Office M4 ot 772

P ¢ Favorites
# Links
J'! Music
» @ OneDrive
b [&] Pictures
#P Saved Games
)’-" Searches
» B Videos
.4 Windows
P = Samsung USB (D)

File name: | C\Users\user\Desktopitest1-1.pll

Save as type:  Patrol Files (*.pll)

Save Cancel

® Save: Click 'Save' in the editor list to save the mission to the desired path.

® Read: You can click 'Read’ in the editor list to reload a saved mission to perform

the same task.



Automatic flight with Patrol Planner — Survey mode flight

'Survey Mode Flight' is a specialized function used to produce a single orthophoto of the area
to be photographed, as well as control and monitoring functions, and it is a function that
provides convenience for orthophoto production by creating a zigzag flight path in an area
corresponding to the specified area, and shooting and saving an image file with GPS information

input for each route.

@ Create a 'Survey Flight' route using the Survey Mission Planner

® In the 'Patrol Planner' window, click ‘Add drone’ to select one of the registered

aircraft.

® After 'Add drone’, click ‘Add Survey' in the 'Patrol Planner' window, create 'Survey
Mission Planner' and double-click the area you want to survey or map on the map to

create a blue area within the specified waypoint.
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® In the planner window, set the flight altitude, flight interval, and route angle

associated with the flight.

® In the 'Commands’ tab, you can set ‘Shoot' or '‘Delay’ for each waypoint

created after 'Switch Survey' to apply the desired mission.

® The default value for the time interval is -1, and you need to set it to perform the



correct task for each waypoint section.

® After entering the setting values for flight distance and shooting, click ‘Switch
Survey' to form a zigzag flight area as shown in the following screen, and

waypoints are created every certain section.

@ After detailed settings, '‘Switch Survey’

' Survey Mission Planner e * -
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® Even after 'Survey Switch', if you move the waypoint and press the 'Switch

Survey' button again, the modified area will be modified and applied.

® ‘Flight Altitude’, 'Interval’, '‘Route Angle' and Photo Shooting commands can also

be applied by clicking ‘Switch Survey' after editing.



urvey Mission Planner

Survey Mission Planner
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® After adjusting the settings required for flight, press the 'OK’ button, and the flight
path will be applied to the map as shown in the screen below, and a progress mark
will be generated for each waypoint in the 'Patrol Planner' window.
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® Start flying a survey mission

® Once all the settings have been completed, press the "Start’ button in the 'Patrol Planner'

window to start the automatic flight.
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® Once the flight begins, the aircraft will take off after loading for a short period of
time to upload waypoints, start flying on the specified route, complete mapping

or recording tasks along the flight path, and return to the ‘home point’ for

landing.
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<Example of actual use screen>

The 'Save' and 'Load’ flight path functions can be used in the same way

as regular ‘Mission Flight'.




n Camera Control

@® Camera, gimbal control

You can adjust the angle of the ‘Camera’ and 'Camera Gimbal' mounted on the

aircraft.

In the 'Tools' tab, click '‘Camera Control' to select the camera of the aircraft you

want to control.

stoet Joj

G
1. Aircraft List Window - After setting the registered aircraft through the list

window, you can operate the camera/gimbal using the camera control pad.

2. Play/Stop - Click to connect to the camera mounted on the aircraft and monitor

it. When you want to end monitoring, click the button again to end playback.
3. Record - Performs a recording command to the camera.

4. Shooting Mode/Video Mode - This is a mode that can be saved as a single image

file through the camera during the mission. 5.Press the 'Shoot’ button to save the
image file to the SD card after shootingn . If you press the recording mode again,
it will switch to 'Video Mode' and the 'uShoot "button in 5.0 will change to the

recording function button, allowing you to save the video file to the SD card.n



5. Shooting - You can select and click on 4 shooting/video modes to shoot or

record.

6. Download — Download the recorded video and save it as the specified file.

7. Zoom In/Out — Zoom in and out of the camera lens to zoom in and out of the

desired subject.

8. Secure Gimbal - Secure the gimbal at a set angle. When unchecked, the gimbal

realigns.

9. Gimbal Scanning Mode — You can automatically set the gimbal move to shoot a

wider area you want to monitor.

Turn off automatic scan mode (None) — This is the default state where there

is no operation of the gimbal.

Horizontal Scan Mode - The gimbal automatically operates in the left and right

horizontal directions.

Vertical Scan Mode - The gimbal automatically operates in the vertical

direction up and down.

Horizontal Zigzag Scan Mode - The gimbal moves from top to bottom and

operates horizontally left and right.

Vertical Zigzag Scan Mode — The gimbal moves up and down in a W shape.

10. Gimbal Angle Adjustment — You can adjust the gimbal angle via the controller

or keyboard arrow keys.



Station Control

@ Station Registration

® In the 'Register Station' menu, you can

- 3rgosALES
connect a pre-registered drone to ny B S7 T 9™ MY C§
argosALES. EEER
GECE S8
m  Check 'Station' in the 'Register Station'
window and select ‘Connection Type' bs 280 5&
. . . cE5A
m Station: Set the device (device) to _
GECE A
register as 'Station'. AE0]4 B4R

CHE 2804 31
m  Click the list of equipment

registered in '‘Device Name' and register the station.

B When the registration is successfully completed, the ‘Device Information

Window' displays information about the registered aircraft and the

I
=

connection status. =

-+~ argosALES - o X
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3 PortusSim-01 ‘ $01.00.01 -35.3621891833550= 149.165056943893 = 581.3m
4 PortusSim-02 . $01.00.01 -35.3634184748151%. 149.1653000715415  581.3m

®  On the map, the station is Emarked with , xso you can identify

the location of the drone and the station.




@ Station Control

e The station provides a place for the drone to take off and land, and the auto-
charging function automatically charges the drone battery after landing before

takeoff or after returning.

e Inthe Tools' tab, click ‘Control Station’ to select the station you want to control.
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® Charging Current (A) - Set the current value at which the battery is charged through
the station to make the battery charge time and battery maintenance cycle more

efficient.

® Cut-off current (A) - When the battery reaches the set current value, stop charging

and allow it to switch to the charging OFF state.

e Manual Charging Mode - Rather than automatically starting charging as soon as the
drone finishes landing, let the user set whether or not to charge. After checking the

manual charging mode, use the following functions.

m  Stop Charging - Disables the station's automatic charging. Drones that are set to
'Stop Charging' will wait at the station without charging immediately after landing

at the station.

B Beacon on - Activates the landing beacon mounted on the station to facilitate the
drone to make a precision landing. You can check the display when the landing
beacon is on % , and the display when it is turned off % through the 'Device

Information' window.



m Other setup instructions

® Application Settings

OHZ 27 o4 A .= Screen Style: Allows you to change the program theme

S AEPY color.
® BHERC
ogazc o m [nitial map location: You can set the location of the
£7] XIS 914 map screen displayed when the program is launched.
Y= 374037132 /= : :
He 57 1601491 (Enter Latitude and Longitude to change.)
AE | ME 7 m Test flight settings: When using the 'Basic Flight
OIFd= 10 Im Test' provided by the 'Drone Control ' panel, you can
HTOUSAS| 3 om erform the test by entering the desired test settings
HE 0 M2 3 - m P y 9 gs.
T OEHE g I m

o MQTT Broker Default URL: Allows you to enter the

default URL settings for the MQTT protocol.

LORA_DEVICE_FILEtxt

® MQTT Broker Default Port: You can enter the MQTT
MOQOTT Broker Default URL
default port settings.

127.0.0.1
MQTT Broker Default Port ® Patrol Settings: When the patrol flight is stopped,
1883 the aircraft will operate at the specified settings.

[ %= 0/CI0f T2 e 2E 75 1. RTL: The aircraft returns to the home point.

Patrol 27 2. HOVERING: Hovers from the point where the aircraft
) RTL . ,
@ HOVERING stopped patrolling flight.
) LAND
3. LAND: Land at the point where the aircraft stopped
2ol S

patrolling flight.

If the patrol setting is LAND, you may land at a point where you cannot land

normally (sea level, mountainous terrain, or other places with many

obstacles).




@ Drone Settings

You can adjust the speed and altitude for specific commands on the aircraft, as well as the

EE= U832 JayMiced v
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Failsafe settings.

B I
® Flight Speed: The maximum flight speed of the aircraft can be adjusted.

® RTL Altitude: The aircraft will move by the altitude set when returning to the home
point (RTL).

® landing altitude: The aircraft rises to the altitude set when landing.
® Landing Speed: The descent speed can be set when the aircraft lands.
® Home Location: Displays the location of the home point in latitude/longitude.

® FailSafe setting — In case of an abnormal phenomenon such as low battery or poor
communication quality in the aircraft, it provides a function to automatically return

when the set value is reached.

m  Battery voltage: When the corresponding voltage value is reached, the aircraft will

automatically return.



B GPS Quality: The aircraft will automatically return when the communication quality

value is reached at the corresponding setpoint.

® Automatic Heading at RTL: This function checks whether the aircraft keeps the
direction of the drone in the current direction or switches to the front before takeoff

when the aircraft is running RTL.

m CUSTOMER SUPPORT

For additional information about argosALES' products, including instructions for

troubleshooting S/W issues, please contact our Customer Support Center.

Q: The drone is not connected to the program.

A: argosALES is a program that is in charge of controlling drones and stations in the drone
automatic operation system of Argosdyne Co., Ltd. Since drones and station devices
are customized and provided to the customer, only devices that are pre-registered

under the contract can be connected to a rgosALES.

Q: It seems like the drone is taking longer than usual to connect.

A: This can be caused by poor network quality.

» Main cause

If it is outside the communication distance limit

When interacting with a program in a communication shadow area

- Communication disturbances caused by surrounding objects

Deterioration of signal sensitivity due to bad weather

+ resolution plan
- Check the connection settings according to the communication environment.
- Connecting the aircraft with RF Link It is recommended to use the default
communication speed (57600 baud).

- Connect the aircraft with Cloud Link Please check the Internet signal sensitivity.



- Use in areas where there is no radio interference and signal sensitivity is strong.

Q: When | press Move to Location, the location of the drone does not appear on the map.

A: Check the connection status of your device. If the drone or station is not properly
connected to argosALES, the default location will be displayed on the map because

valid location information cannot be received.

Q: 1don’t fly on the route | created in Mission Planner.

A: Make sure that you have uploaded the route you created with the Patrol Planner to
the drone via the '‘Read’ function. It flies according to the information you uploaded at

the very end.

Q: Pressing the Arming button won't start the drone.

A: First check whether the drone's Link connection status is normal and whether the FC
is in the standby state. In addition, the operating sequence for automatic flight must be
observed. In order to control the drone with argosALES, the ‘Guide Mode' state must
be prioritized. Drone Control > Guide Mode > Start Control > Takeoff Control > in the

order of 'Altitude setting and execution’.
Q: The flight does not start when | press the Start Mission button.

A: First check whether the drone’s Link connection status is normal and whether the FC
is in the standby state. In addition, the operating sequence for automatic flight must be
observed. In order to control the drone with argosALES, the ‘Guide Mode' state must
be prioritized. Drone Control > Guide Mode > Start Control > Takeoff Control > in the

order of 'Altitude setting and execution'.
Q: The drone does not work when | press the Start Mission button again after landing.

A: The operating sequence for automatic flight must be observed. The drone
automatically turns off the engine when the aircraft lands, so if the flight is terminated
by Land or RTL, the aircraft is in a disarming state. To resume automatic flight, check

the mission in the Patrol Planner and press the 'Start’ button to proceed.
Q: I want to pause a drone that is in automatic flight.

A: To pause a drone in autoflight and return it to hovering, press the pause button in the



Patrol Planner. To resume the automatic flight of a suspended drone, press the restart
button button.

Q: Can the pilot control the motion with the remote controller in the middle of an
automatic flight?

A: By changing the mode, it is possible to switch from automatic flight to remote
controller manual operation. Press the pause button in the 'Patrol Planner’ to keep the
drone in a pause state, and then press the A ItHold Mode or PosHold Mode button to

switch flight modes. If the mode conversion is successful, manual operation is possible
via the remote controller.

Q: When do | use AltHold and PosHold Mode?

A: This flight mode is a mode that allows manual control through the remote controller,
and is intended to respond to special situations that require pilot intervention (such as
an emergency landing). You can stop the mission in the middle of an automatic flight

and take over control from the pilot's remote controller to control it yourself.



Q: The TAKEOFF command does not work after the drone's Move action.

A: This is the command sequence that is blocked in the drone's F C for safety. Basic, for
altitude gain during automatic flight, please use the ‘Drone Control’ -> ‘Remote

Control’ function while the aircraft is hovering.
Q: The TAKEOFF command does not work after the drone's Move action.

A: This is the command sequence that is blocked in the drone's F C for safety. Basically,
for altitude gain during automatic flight, please use the ‘Drone Control’' -> ‘Remote

Control’ function while the aircraft is hovering.

Q: | turned on the auto-login function, but it doesn’t work.
A:

@ Delete C:WUsersWusernameWargosAles.msalcache.bin
@ Automatic login check
(® Ales turns off and on

@ confirmation

® Argosdyne Customer Support
& +82 70-5102-1388

% If you are using a communication network such as LTE / wifi, you can solve
any problems that arise related
to the use of the tariff plan, etc., by contacting the contracted

telecommunications company.

® Feedback on this document

If you would like to help us improve this article, please send us your suggestions,

comments, or errors to info@argosdyne.com.



